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Online Maps (EMU Online)

What Is It?

The Online Maps facility (also referred to as EMU Online), is a web browser based GIS
(Geographic Information System) that provides easy access to our asset information and network

records.
Some of the features available are:

o Gazetteer by Postcode, Street, Locality or WPD Equipment
e Use Grid References or Easting/Northing to locate sites
e Query features for further attribution

e Print to high quality PDF
How Do | Access It?

You will need to be a registered user of the WPD DataPortal2 service and have been granted

access to the Online Maps functionality.

After logging in you should see the following item on the Home screen:

Online Maps

Our Online Mapping application (EMU Online) provides
you with access to our network records and information
via an easy to use web interface.

Some of the features available are:

* Gazetteer by Postcode, Street, Locality or WPD Equipment
Use Grid References or Easting/MNorthing to locate sites

Query features for further attribution
Print to high quality PDF

Launch EMU Online

Click on the Launch EMU Online button to begin.
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The Interface

Main Menu

At the top centre of the screen is the Main Menu bar. All of the core functions of the system are
available from the three drop down menus. Certain functionality may not be available in all Views

or to all users.

Click the [?] link next to each menu item to jump to a fuller explanation of each function.

Tools =

Menu

Load Location [?] — As part of the Online Maps service

Load Location we enable users to bookmark up to ten individual

Save Location locations. You can load saved locations from this option.

Gazetteer Save Location [?] - Enables you to save the current on-

screen location for future recall.
Print
Gazetteer [?] — Opens the Gazetteer search options.

Exit

Print [?] — Open the Print to PDF dialog.

Exit — Returns you to the WPD DataPortal2 Home screen.

View

Display Options [?] — Some Views have the option to

Display Options switch certain layers on or off.

Toggle LV Diagram Toggle LV Diagram [?] — Switches the View to the

Toggle HV Diagram '\ schematic view of the LV (Low Voltage) network. The

LV Diagram is currently available in WPD East Midlands
and WPD West Midlands only.

Toggle HV Diagram [?] — Enables switching to various
different schematic views of the HV (High Voltage) and
EHV (Extra High Voltage) network.
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Tools

Feature Information [?] — Allows you to click

on the map to gain further details about the
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Geolocation - .
: Measure Length [?] - Measure linear
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distances.

Measure Area [?] — Measure user defined

areas.

Where Am 1? [?] - Provides the user’s current map location in a number of common formats (i.e.

Grid Reference or Easting / Northing).

Geolocation [?] — Attempts to use your devices location services (i.e. GPS, etc) to position the
map at your current location. The functionality of this service is highly dependent on the hardware

and software configuration of your device.

View Information

The View Information bar is located at the bottom centre of the screen:

Position: 354130.0 : 237195.0 Scale Line: | 5 km | Scale: 1:250,000

The Position field shows the current Easting / Northing location under the mouse cursor.

The Scale Line will resize dynamically as you zoom in / out to provide the user with a rough
perception of distance at the current map scale. To accurately measure a distance, use the

Measure Length [?] tool.

The Scale field displays an approximate value of the current view scale. Due to the variation in

screen sizes and DPI (Dots Per Inch) of modern displays this figure is only an indicator and

Pg. 6



distances should not be “scaled” from measurements taken with a ruler against the screen. Either
use the Measure Length [?] tool or use the Print [?] function to print at an accurate paper based

scale.

Zoom Buttons

If your mouse does not have a scroll wheel or your device does not support “Pinch to Zoom”, you

can use the and icons at the top right of the screen to zoom in and out.

Ordnance Survey Copyright

If the current View contains background mapping data licenced from Ordnance Survey, then the

relevant copyright attribution statement will be displayed in the bottom right of the screen.
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The Map

Controls

If you have used other popular online maps you should find navigating around the map familiar. If

this is your first time using online mapping, do not worry, the controls are simple to pick up.

Pan / Move

To Pan / Move the map:

e Click and hold the left mouse button
e With the mouse button depressed move the mouse, the map will update relative to the
speed and direction of travel

e Release the mouse button at the end of the move

Repeat the above steps to continue moving around. If you already know the specific location you

are looking for, it may prove more efficient to use the Gazetteer [?].

If you are on a device with a touchscreen, in most cases you will be able to “Swipe” to move the

map. This functionality requires touchscreen hardware and software / browser support.

Zoom In / Out
If you are using a mouse with a scroll wheel this will control zooming of the map. Which scroll

direction corresponds to zooming in and out varies across devices!

If you are on a device with a touchscreen, in most cases you will be able to “Pinch to Zoom”. This

functionality requires touchscreen hardware and software / browser support.

Finally, if your mouse does not have a scroll wheel or your device does not support “Pinch to
Zoom", you can use the and icons at the top right of the screen to zoom in and

out.
Levels of Detalil

The map is designed to display only the most pertinent information for the current view scale. As
the map is zoomed in, more information is displayed; this helps to improve legibility and map

performance.
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Mapping Sets

The Online Maps facility contains several different Mapping Sets (or Views) of WPD’s network

assets, details of which are described below:
Main Mapping

This view is the default view presented to the user upon loading EMU Online; it is the

geographic representation of WPD's linear assets and associated equipment.
This view contains:

e Ordnance Survey Map Background — A number of Ordnance Survey’s Open Data
products are displayed between the scales of 1:2,000,000 and 1:10,000. At 1:5,000 scale
the map switches to detailed Ordnance Survey MasterMap. All prints produced from Main
Mapping use MasterMap as the base map.

e WPD Asset Layers — The position and location of WPD owned linear assets at various
voltages (Underground Cables and Overhead Lines), along with associated equipment e.g.
Poles, Towers, Substations, Link boxes or Joint locations.

e Third Party Data — Where it adds value we may include additional data layers from Third

Party suppliers e.g. Flooding Data

X

Contains OS data © Crown copyright and
: < : £ database rights 2016)
Position: 461440.0 : 460040.0 Scale Line: S0 Scala: 1:2,000,000 O (100022488, 100024877, 100021807)

Main Mapping at 1:2,000,000 scale showing EHV network and WPD boundary.
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4
Position: 352142.0 : 239659.0 Scala Line: | 1000 Scale: 1:50,000

Main Mapping at 1:10,000 scale, EHV / HV / LV network and substation labels are now visible.
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Main Mapping at 1:5,000 scale, OS MasterMap now visible.
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LV (Low Voltage) Diagram

The LV Diagram is a geoschematic representation of the Low Voltage portion of WPD’s network
assets. The schematic diagram can be of assistance when viewing complex LV networks in urban

areas.

This view contains:

e Simplified geoschematic route of linear assets
e Substation, Joint, Link box and Feeder Pillar locations

¢ Indicative feeding arrangements for Link boxes and Switches

The LV Diagram is accessed via the Main Menu -> View -> Toggle LV Diagram.

Please note that the LV Diagrams for WPD South West and WPD South Wales are not currently

accessible via the Online Maps system. If you require access to this data, please make a request

via the contact details provided at http://dataportal2.westernpower.co.uk/Home/Contact (A

charge for printing and administration will apply in such cases)
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LV Diagram showing an urban LV network, including substation and link box positions.
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HV (High Voltage) and EHV (Extra High Voltage) Diagrams

The HV and EHV Diagrams are a purely schematic representation of the High and Extra High
Voltage portions of WPD’s network assets.

This view contains:

e Simple schematic representation of linear assets
e “Normal State” feeding arrangements for Circuit Breakers and Switches

e Additional information on certain assets e.g. Transformer kVA ratings
The HV / EHV Diagrams are accessed via Main Menu -> View -> Toggle HV Diagram.

Please note that the HV / EHV Diagrams are based on data extracted from WPD's PowerOn
Fusion systems on a periodic refresh cycle. It may not reflect the current Operational Condition of

the network and should not be relied upon for Operational use.
The HV and EHV Diagrams available are:

11kV - Contains 6.6kV and 11kV network

33kV - Contains 25kV, 33kV and 66kV network

132kV- Contains 132kV network

Exham Rd —'—'ﬂ-

PSin

= =

Sample view of the East Midlands 11kV Diagram.
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Functionality Guides

This section details how to use each of the functions of the Online Maps service in detail.

Load

Location

Clicking the Load button will clear your curmment
map and navigate you to your chosen
location.

Slot  Location Action
1 Broad Street, Hereford Load
2 -
3 -
4 .
5 -
Save Location

Clicking the Save button will store your current
map location and scale.

The Clear button will remove the selected
saved location.

1

Pg. 14

Slot Location Action

- Save

On selecting Load Location from the Main
Menu, the Load Location side panel will be

displayed.

If you have previously saved a site it will be
displayed here. Click the button next

to the site you wish to view.

The map will redraw to the same centre point

and view scale as when the location was saved.

If you do not have any sites saved you will

receive a short message notifying you as such.

The Online Maps service enables users to
bookmark up to ten sites; this is especially
useful if you are likely to view mapping for the

same site repeatedly.

On selecting Save Location from the Main
Menu, the Save Location side panel will be

displayed.

If you have save spaces available, click the

button to bring up a dialog box to

enter a Location name.

If all ten locations are “full” you will need to

delete one first by clicking the

button on the relevant row.



Gazetteer

The Online Maps facility provides three separate Gazetteer options: Place, Equipment and Grid

Reference. On selecting Gazetteer from the Main Menu, the Gazetteer side panel will be

displayed.

Place

Gazetteer

Place Equipment Gnd Reference

Place Search

Search Term
Search Type Postcode
Limit Results 10

B3

Place Search Tips

<

The Search Term field is the location you

wish to search for (See the Place Search

Tips below for details).

The Search Type field is a drop-down
menu with the following options:

Postcode, Road, Place, Whole.

The Limit Results field determines how
many search results are returned. Be
aware that if you search for a very
common Search Term i.e. “High Street”,
that the specific result you are looking for
may not be shown if Limit Results is too

low.

When using the Place Search gazetteer the Search Term field is quite flexible:

e You may enter full or partial search terms for each of the gazetteer types

e You do not need to enter wildcard characters (i.e. *, ? or #)

e Postcodes can be entered with or without spaces

e Road searches can be combined with a place or locality to narrow the search

results (i.e. instead of searching for “High Street”, enter “High Street, Tipton”

Click the button to submit your search request.

Please note that depending on the number of search results that match your request or the

specificity of your Search Term it may take up to twenty seconds to process your request.
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Results

Location
D4 S8EA, Tipton, Sandwell

D%4 8LE, Tipton, Sandwell
D%4 8MH, Tipton, Sandwell
D4 9AR, Tipton, Sandwell
04 8J%, Tipton, Sandwell
D4 8JL, Tipton, Sandwell

D4 8PE, Tipton, Sandwell

Type
Postcode

Postcode
Postcode
Postcode
Postcode
Postcode

FPostcode

Grid Ref
509492

508591
500592
509492
5009591
509591
500592

When your search has been completed,
the Results will be shown underneath

the search panel:

Clicking on any of the search results
shown will cause the map to zoom to

that location.

For each search result we attempt to
display other information that will help
you determine the correct location, for
example providing a Grid Reference or
showing the full Address / Location that

your search term was matched to.

You can refine your location by using the Map to pan / zoom until your desired location is shown.
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Equipment

Gazetteer

Flace Equipment Gnd Reference

Equipment Search

You can search by the following full or partial terms:
+ Substation Name
+ Substation f Equipment Mumber
+ Pole / Tower Mumber

Search Term
Results
site site Name Description Locality
Number
Ground
015829  HIGH STREET Mounteg  CAVtOMDE
(22D8872) CAYTHORPE oie (SK9347)
Ground
HIGH STREET Castle
922230 avaNSEA Mounted  oqgsg3)
Site
Ground Hanham
110161 HIGH STREET Mounted
. (STE4T2)
Site
Ground
910583  HIGH STREET M?u”n:e ,  Litie Bytham
(22D0912) LITTLEBYTHAM (TF0118)
UPPER HIGH Pole
?;j'g;gm} STREET Mounted :"Saprgg:ﬂ
HARFOLE Substation

Ground Weston-Super-
180408 HIGH STREET Mounted  Mare

Site (ST3562)
860798  BONSALL HIGH fﬂ?u”n’;: ,  Bonsal
(12D9500) STREET s (SK2758)
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The Equipment gazetteer allows you
to search WPD's named or numbered

assets.
This includes:

eSubstation Names
eSubstation / Equipment Numbers

ePole / Tower Numbers

Enter the item you are looking for in

to the Search Term field and then

click the button.

When your search has been
completed, the Results will be shown

underneath the search panel.

Clicking on any of the search results
shown will cause the map to zoom to

that location.

For each search result we attempt to
display other information that will help
you determine the correct location, for
example providing a Description or
showing the Locality and Grid Reference

that your search term was matched to.

You can refine your location by using the
Map to pan / zoom until your desired

location is shown.



Grid Reference

Gazetteer

Flace Equipment Gnd Reference

Easting / Northing

Enter a 1m Grid Reference, e.g. 312456 134567.

You may enter a decimal number for greater precision.

Easting

Morthing

OS Grid Reference

Enter an OS5 Grid Reference from 1km to 0.1m accuracy.

€.0. ST1234(1km) to ST123456123456(0.1m}

OS5 Grid
Reference

Pg. 18

If you already know the Ordnance
Survey Grid Reference or Easting and
Northing for your area of interest, you
can use these to zoom the map

directly to these locations.

Easting / Northing should be

entered separately in to each relevant

field.

OS Grid Reference can be entered
with a precision of 1 kilometre to 10

centimetre precision

Once you have entered your co-
ordinates press the [Eliiy  button,

the map will zoom to that location.

You can refine your location by using
the Map to pan / zoom until your

desired location is shown.



Print

The Print function allows the user to print the onscreen map view to an Adobe PDF document.

This document can then be downloaded and (if required) printed to produce a physical paper
copy.

Print Options

Print output is configurable by the user via the drop-down menus in the Print side panel:

e Paper Size - We offer printing to either ISO A4 or A3 sizes in Landscape or Portrait

e Scale - Common map scales (1:50 to 1:1,250) are supported

Area Selection
The extent of the map which will be printed at the current Paper Size and Scale is indicated by
the blue shaded “print area” rectangle. Any changes to the print options will be reflected in the

print area on screen.

Whilst in Print mode, single left clicking anywhere on the map will define that location as the
centre point for the print area. You may also continue to zoom and pan the map whilst in Print

mode; easily allowing you to create a series of prints along a road or route.

Print Settings
ut print
e ar0a

O (100022488, 100024877, 100021807)

L » 7
e\
5
b o Contains OS data © Crown copyright and
/\ databaso rights 2016)

The blue shaded print area denotes the extent of the map to be printed to PDF.
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Printing
Click the [ EiAGIZE=" button to submit your print request to the server. Print requests will be

processed within five to ten seconds, after which you will be offered a download link to retrieve

your document.

You should download your document immediately by clicking the link; this will cause your web
browser to either prompt for a save location or to open the document automatically depending

on your settings.
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Display Options

Display Options

Map Background
> 05 Mapping

> Developer Plans

WPD Assets
Sernvices

LV Mains
6.6/11kV Mains
33kV Mains

GEKV Mains

132KV Mains

Pilot Cables
Substation Names
Substation Internals
Ducts

Cross Sections
National Grid

Surf Telecoms

LA . L . R S A A L . . A

Work Sensitive Areas

Environmental Data
Environmental Sites
Flood Zone 2

Flood Zone 3

Surface Water 1:30
Surface Water 1:100
Surface Water 1:1000
Soil Resistivity Data

b A O . .

Additional Data
» MPAN Numbers

> Wayleaves
» CNGISIDs

D00 OO0 0D0OD®N NRNEAODORNMNRAAMRARRJER] BOM ©

|

|

Image for illustration purposes, not all layers

may be available.
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The Display Options side panel contains a list of
all the map layers that are configurable for the

current view.

Layers that are currently enabled will display a
check mark, those that are currently disabled will

not.

For a number of reasons some map layers may be
disabled by default, i.e. data that is not useful to

all viewers or to reduce map “clutter”.

Click in the relevant check box for layers you wish

to show or hide.

Any changes made to these options will not take

effect until you click the

button.

After applying new settings, it will take a few
seconds for the map to update to reflect your new

choices.

If, after making changes, you wish to revert to the

views default settings you may do so by clicking

the button.

Please note that only some views have

configurable Display Options.

Please note that your current Display Options
are also applied to any prints you produce.
Therefore, if you disable layers they will also be

missing from your printed output!



Toggle LV Diagram

Clicking the Toggle LV Diagram option on the Main Menu will swap the current view from Main

Map to the LV Diagram.

The current geographic position and the view scale will be retained, enabling the user to simply

switch between the two map views.

The Toggle LV Diagram tool has no user configurable options.
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Toggle HV Diagram

Opening the Toggle HV Diagram tool will

Toggle HV Diagram

display the associated side panel with the

adjacent message.
Use this tool to switch between the

Geographic and Schematic worlds. . .
2l In the map view, assets that are represented in

Click on the mbol for the substation . . .
.5-; alternate views (i.e. the HV or EHV Diagrams)

that yvou would like to view.

will display with a red and green “bullseye”

symbol at their location:

Toggle HV Diagram

Use this ool 10 switch between the
Geographic and Schematic workds.

Click on the symbol for the substation

hat you would ke 10 view.

300 AL

11V
05 AL kv

b =
)

kv NC pilet

h_.. PIAS 1k ;
pr pilot =, 1 \
i

A= 69/0052 (44G0003)
=P \ DAVENTRY
\ \ 132KV/33KV_S/STN
==

94/0008 (44G3003)!
DAVENTRY

Contains OS data © Crown copyright and
database rights 2016)

Position: 457807.6 : 2627248 Scalo Line: | 10m | Scale: 1:500

O (100022488, 100024877, 100021807)

In the above image you can see multiple bullseye symbols. This site has 132kV to 33kV and 33kV to 11kV
transformers on site; it is therefore present in all three HV Diagram views. There are also two distribution

substations (11kV to LV) in close proximity.

Single left clicking on a bullseye symbol will take you to the associated substations position in the

HV / EHV Diagram.

When viewing one of the HV / EHV Diagrams, clicking the Toggle HV Diagram tool will also
display bullseye symbols. In addition to seeing bullseye targets for other HV / EHV Diagrams, you
will see "Geographic” bullseyes. Geographic bullseyes link to Main Mapping.

Pg. 23



Usa this tool 1o switch belween the -
Geograghic and Schemalic workls.

Click on the symbo for the substation
hat you would Bke fo view. -
T pd 235
(320) (250)
01
o o @ |
410
(0) 94613i
D O Way S|
P

-
=]

SRRNGE

4

-
-

Daven
11kV

[ “H =
- ‘i’ ' ~= ~
g Y A 4
: %g#‘aug
SRAN
480 410
(530) “40)
445
w 44D85
Fraser
13 [

View of the above site in the East Midlands 11kV Diagram. Note that there are links to view the site in both
the 33kV and 132kV Diagrams, in addition to the Geographic bullseye, which links back to Main Mapping.

Pg. 24



Feature Information

The Feature Information tool allows you to query objects on the map to view any additional

attribution or information that may be held for them.

Querying Features
On opening the Feature Information tool, a

Feature Information short message in the side panel will instruct you

to click in the Map view.

Click on the Map to view further information on
atfributed features. Single left click in the Map view to query

Please nofe that not all features are aftributed. features at that location for attribution; results

are returned within a few seconds.

Results
Any attribution for features at your chosen location will be displayed in the side panel at the left
of the screen. The complexity of the result will depend on the number of assets or features

present at the location you queried.

Single Feature

Feature Information

6.6/11kV Mains

11/6.6kV Conductor (UG)
Conductor Type 0075CU
state LIVE
Voltage 1176 6KV
Design Voltage 1KY

Operating Voltage 1RV

Installed Date Unknown

Decom Date
% 185 lc AIXLPE 11kV 0872015

Length 268932

92UNF2

S2UNF3 lo
92/029) (33€9567)
NH SKIPS GRANITE
WAY MOUNTSORREL

g~

Contains OS data © Crown copyright and
database rights 2016)

Position: 456027.7 : 315562.6 Scale Lina: om Scale: 1:1,250 O (100022488, 100024877, 100021807)

In this example, a position with only a single feature present has been selected, an 11kV Underground

Cable. The feature is highlighted with a magenta overlay.
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The Feature Information panel contains three main sections:

Feature Information
Layer Name - Identifies which layer

6.6/11kV Mains < within the view this feature belongs to.
et s TR < Feature Type - Identifies a broad
LRI DTSR < descriptor of the selected feature.
State LIVE
Voltage 11/6.6kV —— Feature Attribution — Attribution or
Design Voltage kv information available for the selected
Operating Voltage 11KV feature, the contents of which will vary
Circuit 920022/0006 Quorn dependent on the type of feature
Route Class Main selected.
CIC Date
In this example the feature is an
CIC Ref
Underground (UG) 11kV Cable and
AoC Ref
Oil or Gas relevant asset information is displayed.
Feeder Section Name The Circuit field contains a clickable link
Installed Date Unknown which will perform a Feeder Highlight [?]
Decom Date for the associated 11kV Feeder.
Length 268932 <«

The Feature Attribution is provided in a tabular format which most web browsers will enable you

to select and copy. This would allow you to paste information into other documents.

If you have any queries regarding the specific attribution of a feature, please contact us via the

details provided at http://dataportal?2.westernpower.co.uk/Home/Contact
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Multiple Features

Where there are multiple features present at your chosen location the Feature Information panel

will contain a slightly more complex structure, especially if there are features from multiple

different layers present.

Feature Information

6.6/11kV Mains

11/6.6kV Conductor (OH)

Conductor Type 3w 33 HDC
State LIVE
Voltage 11/6.6kV

Design Voltage 11kV

Operating 11kV

Voltage

Circuit 340011/0017 Chudleigh
Knighton

Colour Plates

Route Class Main
CIC Date

CIC Ref

AoC Ref

Installed Date Unknown
Decom Date

Length 48.650
11/6.6kV Conductor (UG)
LV Mains

LV Conductor (UG)

LV Conductor (UG)
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In this example there are multiple HV and LV

assets present at the chosen location.

As the assets are present in two different map
layers you will see two corresponding Layer

Names (6.6/11kV Mains and LV Mains).

Under each Layer Name are multiple Feature
Type labels, each one of these corresponds to a

separate asset.

By default, only the Feature Attribution for the

first asset or feature is displayed.

To view the Feature Attribution for the other
assets, click on the associated Feature Type
label. As you mouse over the different Feature
Type labels, the associated asset or feature will

be highlighted with a magenta colour.



Feeder Highlight

The Feeder Highlight tool enables
Feeder Highlight gmg
the user to perform a visual trace of

the extents of HV and EHV Feeders.

Click om an 11kV or higher voltage conductor to visibhy
highlight the extents of the associated circuit to its Normal

Open Point(s). The highlight will extend from the

feeding substation to the associated

Normal Open Points.

Feeder 1
Up to three feeders can be
Source No highlighted simultaneously.
5'Eﬂk9f Please note that you cannot highlight
L]

Non Energised, Non Connected, Low

# Select < % Extent Voltage, Private or National Grid

cables.

To perform a feeder highlight, click the button and then single left click in the Map
view on the cable you wish to highlight. After a few seconds you will see the cable overlaid with a

coloured highlight.
The Source No field will indicate the substation that the feeder is fed from.
The Breaker No field indicates the specific Circuit Breaker the feeder is fed from

You can change the colour of the highlight by clicking in the Colour Box and choosing from one

of the five predefined colours.

Clicking the = ZIExtent button will zoom the Map view to fit the full extent of the circuit in
view. The coloured highlight will cover all cables or conductors that belong to the highlighted

feeder.

Please note if your screen size / resolution is too low or the feeder is particularly large, the map
may zoom to a scale at which the associated network is switched off by the Level of Detail
switching. If this is the case the highlight will still be visible, but you will need to manually zoom

back in to view the network.
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Feeder Highlight

[ ]+]

Click 0n an 11KV or higher voltage conductor 1o visibly ’ TR
o Normal

Open Point(s)

Feeder 1

Source No ;
G

Breaker
No

Feeder 2

Source No

Breaker

No

E Source No
¥ Breaker
No
-

Postion: 458213.6 : 315078.9 Scalo Line:

This screen shows the three Feeder Highlight panels in their default state. Each one will highlight in a

different colour unless otherwise changed.

Feeder Highlight

=]

Click on an 11KV or higher voltage conductor o visibly
i of Normal
Open Poins)

Feeder 1

source No | 920025

Breaker

o - o = R
PrT \! e . |BAl . T
g / e Lt N e
Feeder 2
Source No
Breaker
No

7 Select m iExtent

¥ Breaker
No
=T

Position: 458211.3 : 3150344 Scalo Line:

After performing a Feeder Highlight you can see that the 11kV Feeder running diagonally across the
screen is fed from Substation 920025 and specifically Breaker 0005.

To view the full extent of the Feeder you can click the Extent button.
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Feeder Highlight

Click on an 11KV or higher voltage conductor o visibly
Normal
(Open Poini(s)

After clicking the Extent button we can see the full 11kV Feeder highlighted in yellow.

The feeding substation 920025 (a 33kV to 11kV Primary) is visible in the lower right corner.
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Measure Length

The Measure Length tool allows the user to measure simple linear distances.

To begin measuring:

Measurements are retained on screen until you either close the Measure Length side panel,

select a different tool from the Main Menu or click Clear Measurements

Activate the Measure Length tool, the Measure Length side panel will be displayed
Single left click in the Map view

Move the mouse, as you do so a running length total to the current mouse position will be
displayed

Continue single left clicking if you wish to measure along a route

Double left click to finish measuring, the total length of your measurement will be

displayed at the end point of the line / route

the button.
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Measure Area

The Measure Area tool allows the user to measure self-defined areas.

To begin measuring:

Activate the Measure Area tool, the Measure Area side panel will be displayed
Single left click in the Map view as the corner point of the area you wish to measure
Move the mouse to the next corner point, single left click

You will need to add at least three corner points to create a shape

Double left click the final point to finish measuring, the total area will be displayed in the

middle of the shape

Measurements are retained on screen until you either close the Measure Area side panel, select

a different tool from the Main Menu or click the Clear Measurements

button.
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Where Am |?

Where Am 1?7

Click a location on the map and the sites
coordinates will be displayed below.

Easting /
Northing

Easting /
Northing
(0.001m)

OS Grid
Reference
{1km)

05 Grid
Reference
{0.1m)

Where Am 1?7

Click a location on the map and the sites
coordinates will be displayed below.
Easting / _
Northing 350003 - 235881
Easting /
Northing 350802 524 - 2393880.865
{0.001m)
085 Grid
Reference 205030
{1km)
085 Grid
Reference S0509025398808
{0.1m)
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The Where Am 1? tool allows the user to select
a point on the map and get the exact location
of that point in a number of common Mapping /

GIS formats.

Easting / Northing — Location accurate to 1
metre precision. Easting / Northing is also

commonly known as X/ Y coordinates.

Easting / Northing (0.001m) — Location

accurate to 1 millimetre precision.

OS Grid Reference (1km) — Gives the 1
kilometre Ordnance Survey Grid Reference,

commonly used on printed paper maps.

OS Grid Reference (0.1m) — Gives the
Ordnance Survey Grid Reference, accurate to

10 centimetres.

Example of the format of responses after single

left clicking in the Map view.

You can copy and paste the values from the text

boxes for use in other documents.



Geolocation

The Geolocation tool attempts to use any hardware (GPS) or software features on your device to

centre the map on your current location.

The functionality of this service is highly dependent on the hardware / software configuration of

your device.

The accuracy of consumer GPS fluctuates wildly and even under ideal conditions the

location reported may be +/- 20 metres from your true position.

: Click the button in the
Geolocation =
Geolocation dialog box.

Geolocation services are dependent on the Software and Many web browsers will
Hardware configuration of your device and may need o be
enabled seperately for this functionality to work.

acknowledge that the service is

asking for your devices location

and will prompt you to accept or

The accuracy of Consumer GPS equipment can be +- 20m

under ideal conditions. deny this request.

Location information provided is not a substitute for accurate on-

I —— If you accept, within a few

seconds the map should pan to
i ' the location reported by your
: ; device.

If the map does not pan it is likely that your device does not have the required hardware or

software or that it is not currently configured to work with your web browser. In this scenario you

will need to liaise with your own IT provider to remedy this.
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